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What Is Jump Text?
Reading and editing documents at your PC on-line is annoying at best, and a time-waster at 
worst. When reading a paper document it's easy to flip through each page to quickly find the 
material you want. Reading the same document from a computer screen can be very frustrating...
scrolling line after line, page after page. But aren't computers supposed to make work simpler? 
There should be an easy way to point and click to jump to any part of the document you need. 
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There is. The Windows "Help" system makes use of  "jump text", special text that can jump you 
to any other topic, just by clicking on it (in the Mac world, this is called HyperText). Your word 
processor should be able to create documents which are as easy to use as the Windows "Help" 
system. 
Error: Reference source not found™ can make your on-line documents as user-friendly as the Windows 
"Help" system. It's a utility which enables you to easily create jump text. For example, this 
document (the Error: Reference source not found™ User's Guide), makes extensive use of Jump 
Text. Just like in Windows "Help", Green text means jump. Double-click the green chapter 
titles in the Table of Contents to jump directly to that chapter. Double-click any of the other 
green cross-references throughout this document to jump to a complete explanation of the 
referenced topic.

This method for jumping around documents was pioneered by Woody Leonhard of PineCliffe 
International. It's used extensively in his excellent Word for Windows enhancement package, 
"WOPR" — Woody's Office Power Pack. Special thanks to him for generously sharing his ideas 
and expertise. Our utility, Error: Reference source not found™, makes it easy for non-
programmers to utilize this powerful Word for Windows feature.

Learning how to use Error: Reference source not found™ takes practice. Feel free to use this 
User’s Guide as a practice arena. Create bookmarks (or use the existing ones) and insert jump 
text anywhere in the User’s Guide. Don’t worry about ruining the User’s Guide: we’ve protected
it by disabling the File – Save and File – Save All commands while this document has active 
focus.

About Shareware

Error: Reference source not found™ is shareware, software that lets you play before you pay. In addition 
to the benefits of registration (see §, page 8), you gain by contributing to the continued growth 
of an industry that works for you.

Evaluate Error: Reference source not found™ for 30 days. If you like it (and we're sure that you 
will) send in your registration fee, only $14.95 (see §, page 9). 

§

Using Error: Reference source not found™

The Error: Reference source not found™ screen displays a list of all of thebookmarks in the 
active document. Choose a bookmark, type in a description, and Error: Reference source not 
found™ will put jump text in the active document at the insertion point. That's all there is to it. 
Double-click the jump text to jump to that bookmark location. 

Want to print your document but don’t want to see jump text in your print-outs? No problem. By
default (unless you modify the "Format" settings), jump text is formatted as hidden text. This 
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means that it won’t appear in printed hard copy, but it will be visible on screen (with a dotted 
line underneath). If you want to view your document with WSYWIG accuracy, and don’t want 
to see the jump text on screen, you can easily choose not to view it. (Tools-Options-View).

Unsure about which bookmark to use? Run the included Bookmark Lister™ utility to find out 
what text each bookmark represents (see § page 6 for details).

To test run Error: Reference source not found™, first make sure that your cursor is positioned at 
the correct insertion point. This is where your jump text will be inserted. Then...

1. Run Error: Reference source not found™ 

Mouse
Select “Text Jumper” from the bottom of the Tools menu, or “Jump Text” from the bottom 
of the Insert menu.

Keyboard
Press Alt+Shift+J

Please Note
In order to insert jump text into your document, you must have previously inserted a 
bookmark at the jump destination (see § page 4).

2. Enter text that you want to appear as jump text. This should be a description of the section of
the document that the jump text will jump to. For example, if double-clicking the jump text 
will take you to a section about tax information, you might want the jump text to read, “Tax 
Information”. To make this happen, simply enter “Tax Information” in the text box. 

By default, jump text will automatically be formatted as green, bold, hidden text. (These 
defaults can be modified — press the "Format" button on the main screen to run "Format 
Jump Text". For more information see §, page 4.) The default jump text font will be the 
same as the surrounding text. If you wish, you can also manually reformat the jump text — 
change the font, the hidden text attribute, the point size, color, bold, italic, etc.

3. Tab to the bookmark list and specify a bookmark for the jump text to jump to by 
highlighting an item. Bookmarks appear on the list in alphabetical order.

4. To insert the jump text into the active document at the insertion point...

Mouse
Click the Make button

Keyboard
Press Alt+M
OR tab to the Make button and press Enter

Remember, jump text is formatted as hidden text by default. In order to be able to see the jump 
text you’ve inserted, make sure that the "View Hidden Text" option is on. (Tools-Options-View 
dialog – make sure that the “Hidden Text” check-box under the “Nonprinting Characters” group 
has an X in it.) If the "View Hidden Text" option is enabled, hidden text will appear on screen 
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underlined with a light dotted line. If the option is disabled, all hidden text will remain hidden 
and will not appear on screen. If you will be distributing documents on-line to other users, 
advise them to enable hidden text. Altenatively, you may modify the defaults so that jump text 
isn't hidden (see §, page 4).

§

Formatting Jump Text 
By default, Error: Reference source not found™ formats jump text in bold, dark green characters 
as hidden text.  The bold formatting and dark green color make the jump text easy to spot (as 
long as Word for Windows is set to display hidden text). The hidden text formatting displays on 
the screen, but keeps jump text out of your printed documents.

You may wish to change these formatting defaults to suit your own needs and preferences. For 
example, you could modify the defaults so that jump text is “All Caps” instead of “Bold”. You 
could also modify the default so that jump text is formatted as regular instead of hidden text. 
(But remember, if jump text isn't hidden, it will also appear on the printed page.) The Format... 
button on the Error: Reference source not found™ screen enables you modify the formatting 
defaults. The only thing that you can’t change is the color of the jump text: it stays green, just 
like the Windows Help System jump text. Of course, the formatting of the surrounding text will 
be retained — jump text formatting won’t effect the text that precedes or follows it.

To change the default formatting options for jump text...

1. Run Error: Reference source not found™ 

2. Click the Format.. button OR press Alt+F. This brings up the Format Jump Text screen. If 
this is the first time that you’ve changed the Jump Text formatting, the Bold and the Hidden 
Text check-boxes will be marked with an ‘X’. 

3. To use a formatting option, select the corresponding check-box by clicking it once (so that it 
is marked with an ‘X’). To remove a formatting option, click the check-box again (so that 
the ‘X’ disappears). You can also select formatting options by pressing their accelerator 
keys: “H” for Hidden Text, “B” for Bold, “I” for Italic, and “A” for All Caps.

4. When you are done selecting formatting options, click the OK button or press Enter. The 
next jump text that you insert will reflect the formatting options that you’ve selected.

Important
Changes to default formatting will effect only new jump text created after the 
default formatting options have been modified.  

What Is A Bookmark?

You can’t use Error: Reference source not found™ to create jump text unless you’ve previously 
made one or more bookmarks in the active document. This chapter is meant to teach you the 
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basics of bookmarks. You will learn: how to make, find, and remove simple bookmarks. This is 
as much as you need to know to use Error: Reference source not found™. Much of the 
information in this chapter was based on the text of the "Bookmarks" chapter in the Word for 
Windows Help system.

A Word for Windows bookmark, like the kind of bookmarks that you use to mark your place in
a text, is a placeholder. Think of Word for Windows bookmarks as electronic slips of paper or 
post-its that you put in your on-line document to keep a place. But it has much more 
functionality than a paper marker. You can use bookmarks to mark any amount of text, not just a
particular insertion point. If you have a long document, make bookmarks for passages that you 
refer to frequently. And of course, you can also use Error: Reference source not found™ to make 
dynamic hypertext references to those frequently used passages.

For more information about bookmarks, see the Word for Windows Help system. For an even 
more thorough treatment of bookmarks, how they can be used most effectively, and how you can
avoid potential problems, see Hacker's Guide to Word for Windows (Addison Wesley; 
Leonhard/Chen). 

Inserting Bookmarks

To make a bookmark, first decide what insertion point or block of text that you want the 
bookmark to mark. Then...

1. Position the cursor at the insertion point that you want marked
OR highlight the text that you want marked

2. From the Insert menu, select Bookmark (ALT+I, M)
OR press Ctrl+Shift+F5+F5 

3. In the Bookmark Name screen that follows, type a name for the bookmark

4. Click the OK button OR press Enter.

Please Note
A bookmark name must begin with a letter and can contain only letters, 
numbers, and underscore characters, up to a maximum of 20 characters. The 
name cannot contain a space. It’s helpful to make your bookmark names as 
descriptive as possible. 

Deleting Bookmarks

You can delete bookmarks when you no longer need them. To delete a bookmark...

1. From the Insert menu, select Bookmark (ALT+I, M)
OR press Ctrl+Shift+F5+F5

2. In the Bookmark Name screen that follows, type or highlight the bookmark name you want 
to remove

3. Click the Delete button OR press Alt+D

4. Click the Close button OR press Enter

Text Jumper™ User's Guide 5



Moving Bookmarks

Moving a bookmark means that you take a previously-created bookmark name, i.e. that is 
already marking an insertion point or block of text, and use it to mark a new insertion point or 
block of text. Moving a bookmark should be easy, but it isn’t. If you just move the old 
bookmark name to a new location you're asking for trouble. You'll probably wind up with an 
incredible amalgam of both bookmarks, and have one large bookmark which spans the all the 
material between both.

We strongly suggest that you delete the old bookmark before assigning it to a new location. 
Here’s a technique for doing it simply and safely:

1. Position the cursor at the new insertion point that you want marked
OR highlight the new block of text that you want marked

2. From the Insert menu, select Bookmark (ALT+I, M)
OR press Ctrl+Shift+F5+F5  

3. In the Bookmark Name screen that follows, type or highlight the bookmark name you want 
to move

4. Copy the bookmark name to the Clipboard (Ctrl+Insert).

5. Click the Delete button OR press Alt+D

6. Paste the bookmark name back into the Bookmark Name screen (Shift+Insert) 

7. Click the OK button OR press Enter

§

Error: Reference source not found™  
One of the roughest things about working with bookmarks is... working with them. Those 
cryptic little names that we give our bookmarks make so much sense at the time and then, comes
time to remember what “RBD” stands for – uh oh.... Included in Error: Reference source not 
found™ is a utility which provides an efficient, easy way to nail down your bookmarks. Error: 
Reference source not found™ takes the mystery out of bookmark management. Run it and you 
will get an accurate and easy-to-read listing of all bookmarks in the active document, their 
locations, and the text or insertion points that they mark. Remember, working with bookmarks is
far from foolproof. Sooner or later you're going to jump to a bookmark which looks very 
different than what you expected. Don't panic — run Error: Reference source not found™ 
instead. 
Error: Reference source not found™ is the way to find out:

· Each bookmark name
· Where each bookmark is located
· What text or location is represented by each bookmark
With the click of a button (located on the Error: Reference source not found™ screen) Error: 
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Reference source not found™ lists all bookmarks in the active document, along with their 
page numbers and the text they’re marking. Because Error: Reference source not found™ 

uses bookmarks, we've provided Error: Reference source not found™ to help you keep 
track of your bookmark usage.

How to Run Bookmark Lister 
™

1. Run Error: Reference source not found™ and choose the Error: Reference source not found™ 
utility.

Mouse
Click the List... button

Keyboard
Press Alt+L
OR tab to the List... button and press Enter

2. Error: Reference source not found™ will search the active document for bookmarks. 

3. Error: Reference source not found™ will open a new document and insert the following 
information
· Page number where the bookmark is located: in auto black 
· Name of the bookmark: in dark red 
· Text covered by the bookmark: in dark blue

4. Treat the bookmark list generated by Error: Reference source not found™ as you would any 
document. You may find it convenient to either print the bookmark list or keep the document
open so that it is on hand while you work with Error: Reference source not found™. 

§

Getting Help

On-Line Help

The Error: Reference source not found™ program comes with built in on-line help. From the 
main dialog:

Mouse
Click the Help button

Keyboard
Press Alt+H
OR tab to the Help button and press Enter

The User’s Guide
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The User’s Guide (this document) should provide you with all the information you need in order
to run and register Error: Reference source not found™. Use the § in conjunction with the jump 
text system to navigate the User’s Guide most effectively. 

§

Registration & Payment

Benefits of Paying & Registering
Enjoy the many benefits of registration...

· Run Error: Reference source not found™ from inside any document (not just this 
document), no matter what template it is based on. You'll have access to Error: Reference
source not found™ all the time. 

· Assign Error: Reference source not found™ to any menu, key combination, or icon on the
tool bar.

· Special Bonus. Receive a card entitling you to a free issue of Inside Word for Windows, 
the Cobb Group's invaluable monthly collection of Word for Windows tips and tricks. 
This top rated, easy to read journal will increase your skills and decrease your frustration.
Learn from the experts! (see § page Error: Reference source not found).

· Free technical support (see § page Error: Reference source not found).

· Advance notification of the release of the next major Error: Reference source not found™

upgrade.

§

Bonus: Free Tips & Tricks for Word
You want to get the most out of Word for Windows — that’s why you’re using Error: Reference
source not found™. Get a free issue of Inside Word for Windows and start discovering the "tips 
and tricks" to help you work smarter, not harder. 

Inside Word for Windows is an information-packed “how to” publication from The Cobb 
Group, the world’s leading publisher of software-specific journals. When you register Error: 
Reference source not found™, we’ll mail you a card entitling you to your free issue. Stop fooling
around. Learn time-saving techniques from the experts and become a more productive user. 
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How To Pay & Register
Error: Reference source not found™ costs only $14.95 per copy, or the US dollar equivalent. (New York 
State residents must add sales tax.) 

After payment of this registration fee, you'll receive the Registration License Code to enable 
global installation of your copy of Error: Reference source not found™ (see §).

You will also receive your bonus for paying & registering, your free issue of Inside Word for 
Windows, a monthly journal of tips and tricks from the Cobb Group.

If you plan to use Error: Reference source not found™ in a multiple-user environment, whether
on stand-alone machines or over a network, you may obtain a site license and discounted pricing
from Total System Solutions, Inc. For information about site-licensing and volume discounts, 
call Corporate Sales at 718-375-1261, or leave a message on CompuServe 70154,2463.

Registration

Registration is a three part process. 

1. Completion of the Registration & Order Form (see enclosed ORD_FORM.TXT text file).

2. Payment of the Registration License Fee. Payment can be made in a number of ways:

· charge to your CompuServe account
(if you’re a CompuServe member) 

· check or money order

· credit card

3. After payment, you’ll receive your Registration License Code. This allows you to install
Error: Reference source not found™ globally, making it available to all documents (see §). 

Methods of Payment

Paying Via CompuServe Account 

1. Log onto CompuServe.
2. Go to the Shareware Registration Forum — GO SWREG.
3. Select "Register Shareware" from the main menu.
4. Select Registration ID from the "SEARCH BY" menu.
5. When prompted for the ID, enter 731.
6. This will bring up a description of Error: Reference source not found™. Enter "Y" to charge 

payment to your CompuServe account.
7. Complete the order by answering the remaining questions when prompted.
In addition to ordering and paying via the GO SWREG method, you must also send us your 

registration/order form. Send it to us via E-mail, FAX, or US mail. We need the detailed 
information which you provide with your completed form. We use this information to keep 
you informed of product upgrades, discounts on other software, and to send your free bonus.
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Paying With A Check Or Money Order

Make your check or money order payable to: Total System Solutions, Inc. 
MAIL your check or money order, along with your completed Registration and Order Forms, to:

Total System Solutions, Inc.
1530 East 18th Street, Suite 6H
Brooklyn, NY 11230

Paying With A Credit Card

· CALL in your order to our sales department at 718-375-2997 and give your credit card 
information over the phone, along with the information from your completed Registration 
and Order Forms.

· FAX in your completed Registration Form and signed Order Form to: 718-375-6261.

Please send faxes only during business hours:
Sunday – Thursday 9:00 AM – 6:30 PM EST
Friday 9:00 AM – 3:00 PM EST

Entering The Registration Code

Upon receipt of payment and your completed Registration Form, we’ll send you your 
Registration License Code. Enter the Registration License Code to enable global installation. 
This code is for your copy of Error: Reference source not found™ only (see §, page Error: 
Reference source not found). 

Make sure that this document (JUMPTEXT.DOC) is the only document window open. Click the 
Window menu – if more than one document window is listed, please close all others before 
trying to install.

1. Double-click the Install button.

2. Enter your first name, last name and Registration License Code in the text boxes provided 
and press Enter or click the OK button. 

3. From this point onward, you will be able to run Error: Reference source not found™ from 
any Word for Windows document. You will also be able to associate Error: Reference source
not found™ with any menu, any key combination, or any icon on the tool bar.

  Double Click To Register and Globally Install Error: Reference
source not found™ 

Total System Solutions And You

Tech Support
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Registered users can receive 30 minutes FREE telephone technical support for 
thirty days. After the 30 minutes / 30 days expires, we will continue to provide 
support via mail and CompuServe. Here's how to contact us:
· Telephone: 718-375-1261

Sunday-Thursday 9:00 AM – 6:30 PM EST
Friday 9:00 AM – 3:00 PM EST

· FAX: 718-375-6261. 
Please send faxes only during these hours:
Sunday-Thursday 9:00 AM – 6:30 PM EST
Friday 9:00 AM – 3:00 PM EST

Fax us a detailed description of the problem.
· CompuServe: E-Mail a detailed description of the 

problem to our CIS address: 70154,2463

§

System Requirements
Error: Reference source not found™ is a Word for Windows 2.x product. The formatting in this "on-line" 
User's Guide is optimized for display under Windows 3.1 and uses True Type Fonts. 

Beta Testing Program
Are you a computer "whiz"? Do you have comments about how Error: Reference source not 
found™ could be improved? Maybe you can join the Total System Solutions beta-testing team! If
approved, you'll receive pre-release versions of Error: Reference source not found™ and other 
programs for free. To sign up, call us at 718-375-1261. (Open to registered users only.)

§

Other Products

Fileware™

Fileware™ is a suite of thirteen file maintenance, document management, and program 
launching utilities which integrate seamlessly into Microsoft Word for Windows 2.x. It provides 
the many commonly requested features that Microsoft "forgot" to include. After auto-installation
to the "File" or "Tools" menu, the Fileware™ system is never more than a mouse click or 
keystroke away. Now you can do everything you need without ever leaving Word for 
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Windows...

· Forget File Manager. Make directories; delete, rename, copy or move 
files. Because it's integrated into Word, Fileware™ is more convenient 
and much safer. 

· Forget Program Manager. Launch programs instantly with Run 
Buttons, a customizable toolbox of push buttons (or type a command 
on the convenient Quick Run Line).

· Forget eight character DOS file names. Fast Files keeps a 
customizable list of document descriptions close at hand. Just point 
and click to open the files you want.

· Forget complicated directory paths. Directory Jump gives you push-
button access to the directories you use the most. Just one click jumps 
you anywhere on your PC... or across your network.

· Abolish repetitive keystrokes. Close all open files at the same time 
with just one command. Options include Close Without Saving and 
Prompt To Save.

· Protect your confidential data. Word Lock provides password 
protection for the complete Word for Windows application (not just 
certain files).

· Edit document templates instantly, even if you don't know which 
directory they're in. 

· Exit Windows when you're done working with just one click.
Fileware™ is a powerful yet inexpensive suite of utilities. It was chosen 

one of the "48 Best Add In" products by PC Magazine; PC Week says,
"...adds a good selection of file and program management features that
were left out of Word for Windows." In "Hacker's Guide to Word for 
Windows" (Addison Wesley) Woody Leonhard writes, "...the system 
that Microsoft forgot...makes WinWord stand on its ear." 

Fileware™ 2.4 costs only $39.95 per copy.  A fully functioning demo is available. We accept 
Visa, MasterCard and American Express. To order, or for more information call 718-375-2997.

DocuPower Pro™

After you create Word for Windows documents, how do you find them? You know they're on 
your hard drive, or on the LAN file server... somewhere. If only you could remember the file 
name, or the directory — you might actually be able to get some work done.

DocuPower Pro™ breaks the eight character DOS file name barrier! 

Give long, descriptive names to your documents — up to 45 characters long. DocuPower Pro is 
a total document management solution that makes it easy to quickly access your work. On stand-
alone PC’s as well as across networks, it can completely organize your documents. Best of all, it 
integrates seamlessly into WinWord. 

Check Out These Incredible Features 
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· Break the eight character DOS file name barrier. With DocuPower Pro you can give your documents real, 
meaningful descriptions — up to 45 characters long! 

· Assign enhanced DocuPower Pro descriptions while maintaining your original file names. You’ll never 
misplace a file again. Use DocuPower Pro descriptions for fast access, or, if you prefer, look at the regular 
path and file name.

· Get organized — it’s fast and easy. Create an unlimited number of folders for your documents, and give each 
folder its own descriptive title. 

· Each folder holds an unlimited number of document descriptions. Add as many as you like, because they’ll be
displayed in alphabetical order. Simply touch the keyboard to jump immediately to any part of the list.

· Lightning fast folder list display! See hundreds of files instantly.

· Toggle folder list displays instantly between DocuPower Pro document descriptions and DOS file names.

· One file can appear in multiple folders simultaneously. This enables you to organize the same material in 
different ways while avoiding version control problems. 

· Because it’s tightly integrated into Winword, DocuPower Pro will automatically prompt you every time you 
save a new file. So you’re never more than one keystroke or mouse click away from adding your new work 
directly to a folder. 

· Sophisticated folder management allows you to create, rename, or delete entire folders. Plus you can easily 
move documents from one folder to another. 

· Print single or multiple copies of a document directly from any folder — you don’t need to open the file first. 

· Print all documents in a folder with just one command. 

· Fax documents directly from a folder.

· Insert the contents of one document into another. Clicking the “Insert” button lets you perform automated 
document assembly.

· Integrated File Find and Text Search utilities find the files you need fast. Select multiple entries from the list 
of files found. Open all selected files at once, or add all selected files directly to any DocuPower Pro folder.

· Integrated file management functions enable you to make directories, copy, rename, delete or move files. The
file management window is easy and intuitive to use — a dual list box with file names on the left, and your 
descriptions on the right. Do it all without ever leaving Winword or DocuPower Pro. 

· Print a detailed folder status report. List document descriptions and file names for all documents in any folder
(or just list descriptions which have invalid file paths). 

· Free DocuPower Pro Tool Kit includes powerful WinWord macro utilities: Close All Open Files; Display 
Date On Menu; Exit Windows; Restart Windows; List All Files In Directory; Run Program (Command Line); 
Windows System Status.

· Additional tool kits are available to meet specialized needs. The Writer’s Tool Kit includes the following 
utilities: Font Minder, Text Jumper, BookMark Lister, Edit Templates, Open Most Recent Files, Print All 
Open Files, Compare Documents and Winword INI Changer.

Danger! 
Beware of Conventional Document Management Systems 

Text Jumper™ User's Guide 13



DocuPower Pro is unique. Because we do it all, and do it safely. All document management 
systems are not alike. To appreciate our revolutionary design, it’s important to understand the 
dangers of conventional document management systems. These programs also allow you to 
assign descriptive names to your files. However, to keep track of what description goes with 
which file, they take control of your computer. First, they create their own DOS directories for 
your documents (for example C:\MEZ001A2). Next, they rename each file at the DOS level 
with their own proprietary file names, like L000310.DOC. Finally, the new directory structure 
and proprietary file names are indexed and tracked by their database engine.

And that’s the problem with conventional systems — they take too much control away from 
you. As long as your descriptive names are viewed from inside their program, everything is 
fine. But if you want to find a file on your own, you’re out of luck. Just try figuring out what C:\
MEZ001A2\L000310.DOC means!

This can be a real problem. If you need to copy directories or files to a diskette, you’ll be stuck. 
The names that the document management program assigns are totally meaningless to you. So 
using any file management program becomes impractical. Backing up your data also becomes 
either difficult or impossible. How can you back up your documents when you don’t know 
where they are or what they’re named?  

We believe that the benefits offered by these programs are outweighed by the price you have to 
pay. It’s just never worth it to give up complete control of your system. 

DocuPower Pro’s Revolutionary Design

Unlike ordinary document management systems, DocuPower Pro enhances rather than replaces 
your existing directory structure and file names. You’ll always have it both ways. Assign long, 
descriptive names to your documents. Retain your original directory structure and file names. 
DocuPower Pro puts you in complete control. 

DocuPower Pro gives you the power you need to always be in charge of your documents. Try it 
yourself and see what it's like to always have your files at your fingertips.

Call Today!

DocuPower Pro costs only $59.95 (hundreds less than other document management systems). It 
is optimized for use on stand-alone PC’s as well as networks. (Discounted prices are available 
for site licenses). Your satisfaction is guaranteed. If you aren’t completely happy with 
DocuPower Pro, we will promptly refund your money. A fully functioning demo is also 
available. We accept Visa, MasterCard and American Express. To order, or for more 
information call 718-375-2997. 

Please call 718-375-2997 for demo disks & ordering information.

§

Custom Applications
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Word for Windows can do great things! Error: Reference source not found™ is a good example. 
Ask yourself what you really wish computers could do. Then call us. 

Total System Solutions, Inc. creates customized Windows solutions for serious business users. 
We've developed turn-key Word for Windows applications to automate document processing for
many major corporations. If you work with words or numbers in Windows, we can really help 
you. 

For example, we recently developed a system to automate the generation of commercial leases 
for one of the largest commercial real estate management companies in the world. The time 
required for the creation of customized leases was cut from over 2 weeks to under 20 minutes 
per lease!

We can save your company time and money while improving and standardizing the quality of 
your output.

Call us today at 718-375-1261 for more information.

§

Legal Notices
Error: Reference source not found™ 
Copyright © 1993 by Total System Solutions, Inc. 
All rights reserved.
Error: Reference source not found™ consists of the main interface and all of its component macro 
applications and libraries.
Error: Reference source not found™ and all its components are copyrighted to Total System Solutions, Inc. 
All rights reserved. For information on single user registration, see the "Registration" section of 
this document; for information on multiple-user site licensing, please contact Total System 
Solutions directly at 718-375-1261. 

Software License
Error: Reference source not found™ is not public domain software, nor is it free software. The use of Error: 
Reference source not found™, except in demo form for the 30-day trial period, requires 
registration. Non-licensed users are granted a limited license to use the demo version of Error: 
Reference source not found™ on a 30-day trial basis for the purpose of determining whether
Error: Reference source not found™ is suitable for their needs. The use of Error: Reference 
source not found™ even in demo form, except for the initial 30-day trial period, requires 
registration. The use of unlicensed copies of Error: Reference source not found™, demo or non-
demo versions, outside of the initial 30-day trial period, by any person, business, corporation, 
government agency or any other entity is strictly prohibited. 

A single user license permits a user to use Error: Reference source not found™ only on a single 
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computer. Licensed users may use the program on different computers, but may not use the 
program on more than one computer at the same time. A site license permits a company with 
multiple users to use several copies of Error: Reference source not found™ on stand-alone 
computers, or to use a single copy of Error: Reference source not found™ over a network. Site 
licenses must be arranged for individually with Total System Solutions, Inc. No one may modify
or patch the Error: Reference source not found™ code in any way, including but not limited to 
de-encrypting, disassembling, or otherwise reverse-engineering the program. 

A limited license is granted to copy and distribute demo version copies of Error: Reference 
source not found™ only for the 30-day trial use of others, subject to the above limitations, and 
also the following: 

1. Error: Reference source not found™ must be copied in unmodified form, and the demo 
version only may be copied. Users with registered copies of Error: Reference source not 
found™ may not copy their installed version of the program for the use of others, even on a 
trial basis.

2. The full machine-readable Error: Reference source not found™ documentation , complete 
with this license information must be included with each copy. 

3. Demo versions of Error: Reference source not found™ may not be distributed in 
conjunction with any other product without a specific license to do so from Total System 
Solutions, Inc. Distribution of non-demo versions of Error: Reference source not found™ is 
strictly forbidden.

4. No fee, charge, or other compensation may be requested or accepted, except as authorized 
below:

a. Operators of electronic bulletin board systems (sysops) may make demo versions of
Error: Reference source not found™ available for downloading only as long as the 
above conditions are met. An overall or time-dependent charge for the use of the 
bulletin board system is permitted as long as there is not a specific charge for the 
download of Error: Reference source not found™.

b. Vendors of user-supported or shareware software may distribute demo versions of
Error: Reference source not found™, subject to the above conditions, without specific 
permission. Such permission is usually granted. Vendors may charge a disk 
duplication and handling fee, which, when pro-rated to the Error: Reference source 
not found™ product, may not exceed four dollars.

c. Non-profit user groups may distribute copies of the Error: Reference source not 
found™ demo diskette to their members, subject to the above conditions, without 
specific permission.  

Limited Warranty

Total System Solutions, Inc. guarantees your satisfaction with this product. We're so sure 
you'll love it that we will refund your money for a period of  30 days from the date of original 
purchase. If you are unsatisfied with Error: Reference source not found™ at any time within 
that period, please contact us for a full refund.
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Total System Solutions, Inc. warrants that the program will perform in substantial compliance 
with the documentation supplied with the software product. If a significant defect in the product 
is found, the Purchaser may return the product for a refund. In no event will such a refund 
exceed the purchase price of the product.

EXCEPT AS PROVIDED ABOVE, TOTAL SYSTEM SOLUTIONS, INC. DISCLAIMS 
ALL WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE PRODUCT. SHOULD 
THE PROGRAM PROVE DEFECTIVE, THE PURCHASER ASSUMES THE RISK OF 
PAYING THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR 
CORRECTION AND ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES. IN NO 
EVENT WILL TOTAL SYSTEM SOLUTIONS, INC. BE LIABLE FOR ANY DAMAGES
WHATSOEVER (INCLUDING WITHOUT LIMITATION DAMAGES FOR LOSS OF 
BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS 
INFORMATION AND THE LIKE) ARISING OUT OF THE USE OR THE INABILITY 
TO USE THIS PRODUCT EVEN IF TOTAL SYSTEM SOLUTIONS, INC. HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Use of this product for any period of time constitutes your acceptance of this agreement and 
subjects you to its contents.

U.S. Government Restricted Rights

Use, duplication, or disclosure by the Government is subject to restrictions as set forth in 
subdivision (b)(3)(ii) of the Rights in Technical Data and Computer Software clause at 
252.227-7013. Contractor/manufacturer is Total System Solutions, Inc. 1530 East 18th Street,
Suite 6H, Brooklyn NY 11230.

Trademarks

Microsoft and MS-DOS are registered trademarks of Microsoft Corporation. Windows 3.0 and
Windows 3.1 are registered trademarks of Microsoft Corporation. Word for Windows is a 
registered trademark of Microsoft Corporation. Error: Reference source not found™ is a 
trademark of Total System Solutions, Inc. 

§
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